DIGITIZING MUSEUM OBJECTS: 
THE ELMER HARVEY BONE PHOTOGRAPHIC COLLECTION 

By 

LOURDES SANTAMARIA-WHEELER 

A PROJECT IN LIEU OF THESIS PRESENTED TO THE GRADUATE SCHOOL 
OF THE UNIVERSITY OF FLORIDA IN PARTIAL FULFILLMENT 
OF THE REQUIREMENTS FOR THE DEGREE OF 
MASTER OF ARTS 

UNIVERSITY OF FLORIDA 

2009
To my husband, Rick
ACKNOWLEDGMENTS

First and foremost I would like to thank my family for their love and support throughout my education. Their belief in me made this journey possible. I would also like to thank my husband, parents and siblings for their patience while accompanying me to countless museums and galleries. I am grateful to my professors, especially Dr. Glenn Willumson and Mrs. Dixie Neilson, for pushing me to succeed regardless of the obstacle. In addition, I would like to express my gratitude to the staff at the Digital Library Center and Matheson Museum; this project would not have been possible without them. Finally, I would like to say thank you to my friends who provided emotional support and endless entertainment in my years at the University of Florida. Thank you and go gators!
# TABLE OF CONTENTS

ACKNOWLEDGMENTS ............................................................................................................... 4  
LIST OF TABLES ........................................................................................................................... 7  
LIST OF FIGURES ......................................................................................................................... 8  
ABSTRACT ..................................................................................................................................... 8  

CHAPTER

1 INTRODUCTION .................................................................................................................. 11  
Creating an Online Collection: The Digitization Process ....................................................... 16  

2 THE ELMER HARVEY BONE COLLECTION .................................................................. 28  
Alachua County Historic Trust: Matheson Museum, Inc ....................................................... 28  
University of Florida Special and Area Studies Collections, George A. Smathers Libraries ................................................................. 28  
University of Florida Digital Library Center ................................................................. 29  
Elmer Harvey Bone ................................................................................................................ 29  
Reasons to Digitize the Elmer Harvey Bone Collection ..................................................... 30  

3 INNOVATIONS IN ONLINE DIGITAL COLLECTIONS .................................................. 37  
Flickr: The Commons and the Library of Congress ............................................................... 37  
Steve.Museum ........................................................................................................................ 40  

4 CONCLUSION ...................................................................................................................... 44  

APPENDIX

A FLATBED SCANNING: USING THE EPSON EXPRESSION 10000XL .......................... 47  
Tips ......................................................................................................................................... 47  
Scanner Settings ...................................................................................................................... 47  
Scanning ................................................................................................................................. 49  
Saving Files ............................................................................................................................ 50  

B IMAGE CORRECTION USING ABOBE PHOTOSHOP .................................................... 51  
Straightening Images .............................................................................................................. 51  
Color Correction .................................................................................................................... 52  

C DIGITAL COLLECTION STATISTICS ........................................................................... 54
<table>
<thead>
<tr>
<th>Table</th>
<th>page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1 Top fifty most accessed items within the Elmer Harvey Bone Collection, as of March 1, 2009</td>
<td>54</td>
</tr>
<tr>
<td>1-2 Elmer Harvey Bone digital collection history, as of March 1, 2009</td>
<td>55</td>
</tr>
<tr>
<td>1-3 Item views within the Elmer Harvey Bone digital collection, as of March 1, 2009</td>
<td>56</td>
</tr>
</tbody>
</table>
# LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>Elmer Harvey Bone Collection home page on the University of Florida Digital Collections website.</td>
<td>24</td>
</tr>
<tr>
<td>1-2</td>
<td>“Frontal View of D.M and Jewel Cellon’s Home,” item MH00002174, Verso.</td>
<td>24</td>
</tr>
<tr>
<td>1-3</td>
<td>“Portrait of Moon ‘Mike’ Mullins,” item MH00002406, Verso.</td>
<td>24</td>
</tr>
<tr>
<td>1-4</td>
<td>“Florida Motor Court,” item MH00001923. A) uncorrected, raw scan. B) corrected image.</td>
<td>25</td>
</tr>
<tr>
<td>1-5</td>
<td>“Funeral Home on W. University Avenue,” item MH00001925. A) uncorrected, raw scan. B) corrected image.</td>
<td>25</td>
</tr>
<tr>
<td>1-6</td>
<td>“Dudley Farm,” item MH00002318. A) Page Image view. B) Zoomable view. C) Map It! view. D) Citation view.</td>
<td>27</td>
</tr>
<tr>
<td>2-1</td>
<td>The Bone Studio located at 105 S.E. 1st Street, Gainesville, Florida. A) “Bone Studio and Lafayette Electronics,” item MH00002140. B) “Elmer Harvey Bone Standing in Doorway of His Studio,” item MH00002561.</td>
<td>34</td>
</tr>
<tr>
<td>2-2</td>
<td>“Portrait of Glenna Jo Hair,” item MH00002372.</td>
<td>34</td>
</tr>
<tr>
<td>2-3</td>
<td>“Fingate Baby, Thomas Funeral Home,” item MH00002275.</td>
<td>34</td>
</tr>
<tr>
<td>2-4</td>
<td>“2 Men in Swim Trunks; Coleman Clark,” item MH00002192.</td>
<td>35</td>
</tr>
<tr>
<td>2-5</td>
<td>“University of Florida Building Project, Dorm S,” item MH00002146.</td>
<td>35</td>
</tr>
<tr>
<td>2-6</td>
<td>“Construction of Hotel Kelley (renamed Seagle Bldg),” item UF00034740.</td>
<td>35</td>
</tr>
<tr>
<td>2-7</td>
<td>“Construction of New Alachua County Court House,” item MH00002345.</td>
<td>36</td>
</tr>
<tr>
<td>2-8</td>
<td>“S. Clark Butler Standing in His Grocery Store,” item MH00002562.</td>
<td>36</td>
</tr>
<tr>
<td>3-1</td>
<td>“Suffragettes with flag,” as seen in the Library of Congress “photostream” on The Commons website.</td>
<td>42</td>
</tr>
<tr>
<td>3-2</td>
<td>“Bazaar Through Glass Door, Bombay,” as seen in the steve tagger on the steve.museum website.</td>
<td>43</td>
</tr>
</tbody>
</table>
Increasingly, museums are implementing digitization projects as a means to preserve their collections and reach a wider audience. No longer are they skeptical of technology or reproductions but rather they are embracing both with varied success. The benefits of digitization can be seen in thousands of museum websites as well as in internal and public databases. By means of publicly accessible websites, the reach of museums has extended beyond its white walls. They can now serve audiences across the world at any time, not just during business hours.

Inspired by the possibility of public access and noting the need for preservation, I digitized approximately 760 items from the Elmer Harvey Bone Collection housed at the Alachua County Historic Trust: Matheson Museum, Inc. The resulting digital surrogates are at the core of the Elmer Harvey Bone Collection online. I also integrated into the digital collection more than 250 images from the University of Florida Special and Area Studies Collections, George A. Smathers Libraries that were taken by Mr. Bone. Since the Bone Collection is divided between two institutions, it cannot be seen in its entirety at one time. This project allows for a portion of the collection to be united digitally. The collection consists of photographs, both plastic and glass
negatives, and positive transparencies, taken by E.H. Bone in the first half of the twentieth century.

Elmer Harvey Bone was a photographer who documented the everyday in West Virginia and Florida. He opened his own photography studio, in 1902, at the age of 17. In 1925, Mr. Bone arrived in Gainesville, Florida and began his forty-three year career as a local photographer. His images tell the story of a small town, its growth, and its residents. Without Bone’s photographs, the vernacular history of Alachua County and its surrounding areas would be lost to the mostly temporary inhabitants of Gainesville, Florida.

The Elmer Harvey Bone Collection is presented online as a part of the University of Florida Digital Collections (UFDC). The University of Florida Digital Collections is a free, publicly accessible website that provides integrated access to libraries, museums, and archives. It is a comprehensive research portal containing text, images and ephemera, all of which are cross-searchable. In addition, the items can be searched by author/artist, title, year, or subject keyword. Items also have zooming capabilities and pinpointed Google map locations when available.
CHAPTER 1
INTRODUCTION

The primary responsibility of a museum is to its objects. Digitization aids the museum’s mission to protect and display cultural heritage. Increasingly, museums are implementing digitization projects as a means to preserve their collections and reach a wider audience. No longer are they skeptical of technology or reproductions but rather they are embracing both with varied success. The benefits of digitization can be seen in thousands of museum websites as well as in internal and public databases. By means of publicly accessible websites, the reach of museums has extended beyond its white walls. They can now serve audiences across the world at any time, not just during business hours.

There are many reasons to digitize museum collections. Digitized collections allow the museum to facilitate access to the general public. Museums are open a limited number of hours a week, and even when the physical doors of the museum are open only a small percentage of items are available to view. Due to space and preservation needs, a large portion of the museum’s treasure is kept locked away for the majority of the year. At any given time less than 2% of the Smithsonian Museum’s 137 million artifacts are on display.¹ The Smithsonian is much larger than most museums with 137 million artifacts; yet nationwide 80% of museum collections are kept in storage.² Therefore, when these treasure chests are opened, it is usually only to a select number of very specialized researchers. Through digitization, not only are the doors swung wide open, they remain open twenty-four hours a day and three hundred sixty-five days a year.

---


Although digitization of museum collections facilitates access, it does have limitations. The freely available format of digital surrogates is more democratic than the brick and mortar museum yet it is still not truly available to all. Digital surrogates are only available to those with access to a computer that is connected to the Internet. Therefore the newly “world accessible” items are still not widely available to many in the developing world or to the poor. A computer with Internet access is often sufficient since many museum websites utilize thumbnail images that do not require a robust computer or high-speed Internet access.

Digital objects not only increase access to the museum, but also increase availability of museum staff. Every museum has limited budget and staff. Making collections available digitally frees up the museum staff from having to supervise access in research rooms and respond to requests. Curators can especially benefit from digitized items by utilizing them to plan exhibits more efficiently. When digital surrogates are available, the curator can create an object list without having to search the storage rooms. This saves time and reduces potential damage to objects from accidents or misplacement upon their return. Furthermore, the curator can use digital surrogates to plan an exhibit’s layout and therefore facilitate a swift hanging process for the preparation staff.

Reproductions are frequently the only accessible way to see works of art. Due to time and travel constraints, 35mm slides as well as the more current digital surrogates, stand in place of original works in art history courses. In addition to slides and digital images, countless posters, prints, coffee mugs and many other sub-par reproductions demonstrate that people are still fascinated by original works. Klaus Müller states that, "love for art and culture is nurtured by reproductions; book and catalogue illustrations; postcards; posters, and now, thumbnails."
[Additionally] Much of what we know about Greek culture comes from Roman reproductions.\textsuperscript{3} Therefore, it is reproductions that have shaped our knowledge of art history and will continue to do so.

Digital access increases visits to the original artwork as well. In spite of the abundance of reproductions, copies and digital images, people still line up to see da Vinci's \textit{Mona Lisa}, Van Gogh's \textit{Starry Night}, and many other works that bombard us everyday through reproductions and advertisements. Maxwell L. Anderson, director of the Indianapolis Museum of Art, believes that "the oft-repeated fear that providing multimedia encounters with artworks will diminish the potential viewer's appetite for the original is demonstrably false. Their appetite to see and be in the presence of the original work is not only whetted by those lamentable reproductions, but is in direct proportion to the extent to which they have lingered over those illustrations - in textbooks, on postcards, and on T-shirts. The demand for the original work will increase rather than decrease, following repeated exposure at an institutionally authorized site on the World Wide Web or its successor."\textsuperscript{4} Museums should capitalize on this phenomenon by promoting their collections digitally. The increased visits to the physical museum should lessen any fears that digital surrogates will fill the public’s appetite for art.

Digitized items not only fulfill the museum’s educative role but also expand it. Education, along with responsibility to its collections, is integral to a museum’s mission. According to Lynn D. Dierking and John H. Falk, museums are a place for learning yet "individuals who go to museums have explicitly chosen to attend not because of some theoretical interest in learning,


but out of a concrete interest in a particular area or areas of learning, whether science, history or art.”⁵ Therefore it is free-choice learning (learning for fun, not because one has to) that lures people to museums and the same impulse that draws them to visit museum websites. General users are visiting museum sites not for some specific research but rather to browse, to see what peaks their interest. Museums can capitalize on undirected research by providing more browsing options, such as the ability to view collections by medium, artist, or theme. They can also provide the option to arrange search results in a thumbnail grid on their websites, in order to facilitate the users’ desire to browse.

Whether browsing or researching a specific topic, digital surrogates encourage greater scholarship and research. “Imaging applications allow users to alter an image to prove a hypothesis [by zooming in or cropping] and bring together physically disparate pieces for comparisons that otherwise would not be feasible.”⁶ Through the Internet, users can easily inspect the surrogate and compare it to other items both within the same museum’s collection and throughout the world. They may find similarities in other objects from the period, compare poses in an artist’s career or research the many depictions of a certain landscape; all without having to consult various textbooks or visit many museums. Furthermore, if the surrogate is of high enough resolution the user can magnify details that would be difficult to see when visiting an original; thus increasing research potential.⁷

---


⁷ For an example of museum artifacts online (in high resolution) which allow magnification and facilitate research, see the University of Florida Digital Collections, The Arts of Africa. Available at http://www.uflib.ufl.edu/ufdc/?s=artaf&m=hball. Specifically item UF00083074, Male Royal Ancestor Mask http://www.uflib.ufl.edu/ufdc/?s=artaf&m=hd1X&i=74634&vo=02&vp=820,412 (Accessed 15 February 2009).
Museums can use their websites to provide digital images of the collection as well as include additional information about the objects. Descriptive texts from wall labels are becoming more common to include with the surrogate, but the possibilities are there to include much more. Additional information such as artist and/or period background, art historical timelines, and related works can also be included. Items may even include multiple readings/interpretations by various scholars. "The provision of varying levels of interpretation is one of the benefits of digital technology - rather than the watered-down lowest common denominator known as the wall label - digital access will allow any user with any background to feel at ease with interpretive material. Thus the museum can actually furnish more information more easily to more users than before."\(^8\) Since the Internet allows for more space than the physical museum, more information about the objects is possible.

Many people search the Internet for information before their intended museum visit. That search may be for museum hours, a location map, or to see the exhibition schedule. Yet increasingly people are searching the Internet before visiting a museum to learn about the collections or plot the galleries they want to see. “Some [visitors] - more and more, in fact - want information in advance of their visit to the galleries, via the Web, and a smaller number will take the time to return to the museum's website after their visit to learn more.”\(^9\) Digitized surrogates on a museum’s website enable visitors to see a preview of their visit and possibly find something they would have skipped. For example, a potential visitor to the Louvre Museum may search their website to find exactly where the *Mona Lisa* is located within the museum in order to not miss one of the most famous works of art. In their search they discover that the museum has

---


many other works by da Vinci that are equally stunning. *The Virgin of the Rocks* may catch their eye. The visitor can then add that painting to their list of works to see and will probably further search the website to find other works they were unaware of. This makes their visit more fruitful since they will spend their limited time experiencing the works of art rather than trying to see everything.

Digitization not only helps preserve a work of art but it also increases its longevity by reducing handling and environmental exposures to the original. "Only after viewing a selection of surrogates might a researcher need to see an original item, reducing the wear and tear of moving items in and out of storage."\(^{10}\) If the item is not being transported to and from storage there is less chance of physical damage through mis-handling or accidents. Additionally if the item is in storage for longer periods of time, then it remains more stable by not being exposed to additional light and climate changes. Of course digitization as an aid in preservation is only successful if the appropriate equipment, one that is designed to specifically handle books for example, is utilized and should not be the only strategy for a museum.

**Creating an Online Collection: The Digitization Process**

Inspired by the possibility of public access and noting the need for preservation, I digitized approximately 760 items from the Elmer Harvey Bone Photographic Collection housed at the Alachua County Historic Trust: Matheson Museum, Inc. The resulting digital surrogates are at the core of the Elmer Harvey Bone Collection online (www.uflib.ufl.edu/ufdc/?s=bone). I also integrated into the digital collection more than 250 images from the University of Florida Special and Area Studies Collections, George A. Smathers Libraries that were taken by Mr. Bone.

---

The University of Florida Digital Collections (UFDC) is a free, publicly accessible website that provides integrated access to libraries, museums, and archives (http://www.uflib.ufl.edu/ufdc). The website is hosted and maintained by the University of Florida Digital Library Center (DLC). UFDC has more than thirty collections grouped into several thematic headings including: Arts, Humanities and Social Sciences; Science and Technology; Maps; Florida; and World. Online since March 2006, it is a comprehensive research portal containing text, images and ephemera, all of which are cross-searchable. In addition, the digital items can be searched by author/artist, title, year, or subject keyword. Items within UFDC also have zooming capabilities and pinpointed Google map locations when available.

To present the Elmer Harvey Bone Collection online, a collection was created UFDC’s collection of Florida Photographs.11 Other sub-collections of Florida Photographs include the University Archives Photograph Collection and the Matheson Museum Visual Resource Collection. In order to fit within the UFDC topical collections and increase its findability, I created the Elmer Harvey Bone Collection as a sub-collection of the Florida Photographs Collection. Users may find the Bone Collection because they are interested in photographs of Florida or because they are aware of the collection, as well as through the UFDC search box. Following the established UFDC template, I designed the collection homepage, creating a banner and text describing the collection (see Figure 1-1). I chose an appealing photograph from the collection and reformatted it to create the banner. For the collection text, I referenced the electronic finding aid for the Bone Collection housed at the University of Florida Special and Area Studies Collections, George A. Smathers Libraries (http://www.uflib.ufl.edu/spec/archome/MS38.htm).

11 For more information on the Florida Photograph Collection see http://www.uflib.ufl.edu/ufdc/?c=foto1
Together with the Matheson Museum director and registrar, I decided that the current organization of boxes would be scanned in their entirety rather than selecting individual items from each box. The reason for this was the size of the Elmer Harvey Bone Collection (approximately 10,000 items in the Matheson’s collection). This approach would yield a representative and cohesive digital collection. Beginning with the most fragile glass plates, I digitized one box (ranging in contents from 16 to 150 items) at a time, proceeding sequentially through the physical collection until approximately 1000 images were part of the digital collection. As a pilot project 1000 digitized items were targeted in order to convey a representative sample of the collection.

Items from the Bone Collection were digitized at the University of Florida Digital Library Center (DLC). The DLC already had the necessary equipment and the Matheson Museum could not afford to purchase comparable equipment. The Matheson Museum and the DLC had previously collaborated on several projects, including digitizing thousands of postcards from the Museum’s collection, which facilitated this collaborative effort. Therefore it was not a problem to transport items from the Matheson to the DLC or to ensure their safety. Once a box was identified for digitization, the registrar at the Matheson Museum inspected its contents and transcribed any notes about the images into a Microsoft Word document. The Bone Collection was donated with virtually no documentation; therefore the majority of information about the images came from the prints themselves and/or volunteers’ memories of the subjects. The box and any notes or documentation relating to it were then taken to the DLC for digitization.

The most important part of any digitization project is selecting the appropriate equipment. Both material, including type, age and handling requirements, and final product requirements should be considered before selecting a scanner or digital camera. For example, when digitizing
A Civil War diary, a scanner with a cradle rather than a flatbed scanner should be selected in order to cause as little damage as possible to the original. In this case the scanner is overhead and a cradle holds the diary, evenly distributing its weight so that minimum stress is placed on the binding. The highest final product requirements should also be taken into account to ensure that the equipment selected is capable of producing the necessary resolution in order to only digitize items once. For instance, a painting may be digitized in order to present it on a museum’s website therefore only requiring a resolution of 72 dots per inch. Yet a scanner with the capacity of at least 600 dots per inch should be selected, so that the same image may be used for publication purposes as well as online.¹² This ensures that the item is only handled once. For this project, a scanner capable of handling both prints and negatives was needed, as well as the capacity to scan at a resolution of 600 dots per inch (dpi), as recommended by the Cornell University Library.¹³ The DLC already had several scanners that met these requirements, as well as software to facilitate the creation and upload of digital images. As a result, two Microtek 9800XL flatbed scanners with transparency lids were used to complete the project.

Each item was digitized following Cornell University standards and the Digital Library Center’s recommended best practices. Items were carefully scanned in the necessary color space, 8-bit grayscale for black and white prints/negatives and 24-bit RGB for color prints, at 600 dots per inch. Approximately twenty 35mm color positive slides were also digitized. These were scanned in 24-bit RGB at 4000 dots per inch due to their small size. All items were saved in an archival, uncompressed TIFF format. In addition, any item that had pertinent information on the

¹² A derivative image with lower resolution can be created from a higher resolution original. One high resolution original can yield several lower resolution images for various purposes.

reverse had both sides scanned. For example, several photographs have a stamp from the Bone Studio and a few others are photo-postcards (see Figures 1-2 and 1-3). Digitizing this additional information provides more contextual and historical information to the user and creates a more accurate surrogate.

Due to the lack of written information regarding the collection, each item was visually inspected in order to verify and augment the existing information. As each item was digitized, the registrar’s notes were referenced and the digital image was magnified on screen. More often than not the notes were amended with additional information contained in the image. For example, digitization of an image that was labeled “Downtown Building, N.W. 13 Street” revealed that the building was Bendix Modern Home Laundry and the doorway address read 402. The ability to magnify the digital image allowed me to identify the specific building pictured and discover its address. This was helpful later in the process when adding descriptive metadata to the digital surrogate.

Utilizing the registrar’s notes as well as any additional information discovered in the image, I created a record for each item using the Digital Library Center’s internal tracking database. This database was created by DLC programmers and assigns a unique identifier to each digital item. The identifier consists of eight digits preceded by a two-letter code. It follows the item throughout the process and facilitates file organization. Items digitized for this project have identifiers beginning with MH, identifying the item as part of the Matheson Museum’s collection. The tracking database also simplifies the creation of metadata by providing fields for Author/Creator, Title, Date, Format, Subject, Abstract, Notes, and much more.

Once a record was created and the item was digitized, each image was optimized for screen viewing using Adobe Photoshop CS3. Each image was first straightened and then cropped. In
order to create a faithful digital surrogate, close attention was paid to the original dimensions as well as including the entire image, with negative borders when available. The image was then color corrected by adjusting its histogram levels. Although each image was color corrected and this is a subjective step, several measures were taken to ensure color fidelity to the original artifact. The scanners used in this project were frequently calibrated using Kodak Q60 targets, which ensured that the scanner was accurately capturing the item on its platen. The computer monitor on which these images were adjusted was also calibrated regularly using a calibration spider and the Monaco Optix calibration program. Furthermore, I called upon my photographic training to judge the adjustments needed for each image. Corrections were applied in order to optimize screen and web viewing while maintaining historic fidelity of the original. If the original was underexposed, overexposed, or fading then the digital surrogate is also underexposed, overexposed, or fading; albeit not as dramatically (see Figures 1-4 and 1-5).

The remaining steps, after digitization, were performed using open source software created by the Digital Library Center’s programmers. Each step (program) led to the final product, which was upload onto UFDC. After digitization and image optimization, each package (a folder containing the master TIFFs for each item) was processed through the Pre-QC program. Pre-QC is an automated program that creates derivative files (JPEG and JPEG2000) for web presentation. The package, which at this point contains all the TIFFs and JPEGs, was then reviewed within the Quality Control (QC) program. The Quality Control program facilitates individual review of image files in order to verify that all image requirements (color space, resolution, etc.) were met. For textual documents, QC also assigns pagination and creates a table of contents.
The final product was then ready for upload to the Internet. Each package was sent through the \textit{GO UFDC!} program, which loads the JPEGs and METS\textsuperscript{14} files to the UFDC website. Once online, the entire package, including all associated files, was locally archived to DVD. The DVD archive is maintained within the Digital Library Center. A copy was also stored offsite at the Florida Digital Archive. Since the items digitized are a part of the Matheson Museum’s collection, a DVD copy was also created for their archive. Multiple backup copies ensure that digital data will not be lost due to accident, nature or time. Furthermore, the DLC’s partnership with the Florida Center for Library Automation guarantees that all archival TIFFs will be migrated forward to whatever format is the archival standard in the future.

This project unites a portion of the Elmer Harvey Bone Collection in digital form. In addition to digitizing 760 items from the Matheson Museum, I integrated into the digital collection more than 250 images that had been previously digitized by the DLC. These additional items are from the Bone Collection at the University of Florida Special and Area Studies Collections. They were available online as part of the University Archives Photograph Collection. Using the \textit{METS Editor} program, designed by the DLC’s programmers, I edited the metadata for each of these items in order for them to appear as both part of the original University Archives Photograph Collection and the newly created Elmer Harvey Bone Collection.

Each item in the digital collection has several viewing options, which can be selected through tabs on the upper part of the web page (see Figure 1-6). The standard or default view for most of the digital surrogates is the “Page Image.” This view has the entire image visible. A “Zoomable” view is also available, which provides the user with a thumbnail image on left side

\textsuperscript{14} METS is a standardized metadata schema developed by the Library of Congress. For more information see http://www.loc.gov/standards/mets/
of the page in which to navigate. The actual image can be magnified with the provided plus and minus signs while the arrows allow the user to rotate an image and the squares enlarge it. This is particularly helpful for clarifying background details, reading street signs or general viewing for the elderly or visually impaired. In order to assist in both the findability of the item and its research value, all items have a “Citation” view, which describes the item and provides additional textual information such as original format, notes, subject headings and label text (when available). Some items also have a tab titled “Map It.” This option utilizes Google maps to provide the user with pinpointed locations represented in the image. For the Bone Collection, the location marked on the map is that of the locale pictured. A few items, especially those depicting Mr. Bone’s studio, greatly benefit from this feature since the building no longer exists and/or the street names have changed.
Born January 15, 1886 in Ohio, Elmer Harvey Bone opened his own photography studio at age 17 in 1905, in Gainesville, Florida where he became a partner in Van Sickel and Bone. Later he opened "The Quality Studio" and "The Bone Studio" where he worked as a photographer until 1968 when he retired at age 93. Mr. Bone died on March 12, 1976.

The Elmer Harvey Bone collection is housed at the Alachua County Historic Trust Matlhosten Museum, Inc. and the University of Florida George A. Smathers Libraries. It contains photographs and negatives, mostly taken in Alachua County and its surrounding areas, from the first half of the 20th century. The negatives are both plastic and glass.

Figure 1-1. Elmer Harvey Bone Collection home page on the University of Florida Digital Collections website. http://www.uflib.ufl.edu/ufdc/?s=bone

Figure 1-2. “Frontal View of D.M and Jewel Cellon’s Home,” n.d., 3.5”x2.5”, item MH00002174, Verso.

Figure 1-3. “Portrait of Moon ‘Mike’ Mullins,” 1930s, 5”x3.5”, item MH00002406, Verso.
Figure 1-4. “Florida Motor Court,” 1945, item MH00001923. A) uncorrected, raw scan. B) corrected image.

Figure 1-5. “Funeral Home on W. University Avenue,” 1944, item MH00001925. A) uncorrected, raw scan. B) corrected image.
Figure 1-6. “Dudley Farm,” 1955, 5”x4”, item MH00002318. A) Page Image view. B) Zoomable view. C) Map It! view. D) Citation view.
CHAPTER 2
THE ELMER HARVEY BONE COLLECTION

The Elmer Harvey Bone Collection is separated between two institutions; the Alachua County Historic Trust: Matheson Museum, Inc. and the University of Florida Special and Area Studies Collections, George A. Smathers Libraries. The physical division of the collection hinders its viewing and research potential. It also provides an incomplete view of the collection. This project allows for a portion of the collection to be united digitally.

Alachua County Historic Trust: Matheson Museum, Inc.

Open since 1994, The Alachua County Historic Trust: Matheson Museum, Inc. is dedicated to preserving and interpreting the history of Alachua County. The museum is comprised of four buildings, the Matheson Museum, housing the exhibit hall and research library, the Matheson House, the Tison Tool Museum, and Sweetwater Park. The Matheson Museum features both permanent and temporary exhibits relating to Alachua County. The nonprofit organization is located in downtown Gainesville, Florida in the former American Legion Hall.15

University of Florida Special and Area Studies Collections, George A. Smathers Libraries

Part of the University library system, Special and Area Studies Collections contain non-circulating primary research resources at the University of Florida. Its holdings include the Rare Book Collection, the University of Florida Archives, the P.K. Yonge Library of Florida History, the Belknap Collection for the Performing Arts, and the Baldwin Library of Historical Children's Literature, among many others. The Special and Area Collections support the University

15 For more information about The Alachua County Historic Trust: Matheson Museum, Inc. see http://mathesonmuseum.org/
community and scholars worldwide through its mission to preserve, develop and maintain special and area studies collections.¹⁶

**University of Florida Digital Library Center**

The University of Florida Digital Library Center (DLC) was established in 1999 as a result of several digitization projects originating in the Libraries’ Preservation Department. The DLC is responsible for the creation and maintenance of the University of Florida Digital Collections (UFDC), which are available online at www.uflib.ufl.edu/ufdc. The items digitized by the DLC originate from the University of Florida as well as libraries, museums and archives throughout the world. The organizational units of the DLC include collections, copy control, imaging, text processing, and quality control. The DLC operates primarily through collaborative efforts, inviting contribution from faculty and staff at the University of Florida and other institutions. Currently, the University of Florida Digital Library Center is one of the largest and most successful digitization facilities in the Southeast. It hosts nearly four million pages of digital surrogates on its website.¹⁷

**Elmer Harvey Bone**

We know very little about Elmer Harvey Bone. He was born on January 15, 1885 in Martins Ferry, Ohio. In 1887, when he was two-years-old, his family moved to Wellsburg, West Virginia. While in a high school physics class, Bone took his first photograph as part of a class assignment to construct a camera out of a box. In 1902, he graduated from high school. Shortly thereafter, noting his interest in photography, his father built him a small photographic studio.

---

¹⁶ For more information about the University of Florida Special and Area Studies Collections see http://www.uflib.ufl.edu/spec/

¹⁷ For more information about the Digital Library Center see www.uflib.ufl.edu/digital
From this studio, Bone was a self-employed photographer. His images appeared in both Cleveland and Pittsburg newspapers.¹⁸

In the 1920’s E.H. Bone, together with his wife Margaret and four children, Sarah, Ralph, William, and Elmer, moved to Eustis, Florida. In 1925 the family traveled north and settled in Gainesville, Florida. Once in Gainesville, Bone had a lengthy career as a local photographer. He worked in the studio of Van Sickel and Bone and later opened his own photographic studio. When Bone opened his shop, only one other photo studio existed in Gainesville. He operated the “Quality Studio” for over forty years. The studio was renamed “Bone Studio” after a fire in 1951 (see Figure 2-1). During this time Bone photographed the everyday in Alachua County and the surrounding areas. He took traditional studio portraits, documenting families, births, deaths, engagements and much more (see Figures 2-2 and 2-3). Elmer Harvey Bone was also present at many social gatherings taking spontaneous shots and posing many more (see Figure 2-4). In addition, he documented the growth and expansion of the University of Florida as well as the surrounding areas (see Figure 2-5). Bone was the first studio photographer to photograph Gainesville’s African-American residents, including the graduating classes of Lincoln High School. Elmer Harvey Bone officially retired in 1968 at the age of eighty-three, but continued to photograph the annual University of Florida Homecoming Parade. He passed away in 1976 at the age of ninety.

**Reasons to Digitize the Elmer Harvey Bone Collection**

Upon first glance, the Elmer Harvey Bone Collection is ordinary. The images are like so many we have seen before. Many of us have similar photos in albums, scrapbooks and frames.

¹⁸ Information about Elmer Harvey Bone was gathered from oral history interviews with his children (taken by the staff at Matheson Museum in the 1990’s), Bone collection description from the Smathers Libraries, and various newspaper clippings from *The Gainesville Sun.*
One could argue that the images are not even well taken. Yet the collection is extraordinary in its quantity and timeframe. There are more than 10,000 images spanning more than forty-three years in the Elmer Harvey Bone Collection. The history of an entire town is in these photos.

Elmer Harvey Bone witnessed and photographed many changes in Gainesville and the surrounding areas. In 1925, when E.H. Bone first arrived in Gainesville, the University of Florida was only nineteen years old. It would still be another twenty-two years before women were officially allowed to enroll at the university. In 1958, the school was de-segregated. He saw buildings constructed that are now city landmarks (The Seagle Building and the Court House, see Figures 2-6 and 2-7) and contributed to local history through his frequent documentation of the construction of each. In addition, he photographed residents who are now considered city pioneers and politicians whose names now grace buildings (see Figure 2-8). Elmer Harvey Bone not only photographed the paying public in his studio but also the historic and the mundane occurrences in the region. His collection serves as a reminder of the growing pains of a city and the lives of its residents.

Digital surrogates increase access to museum collections and the Elmer Harvey Bone Collection was mostly inaccessible prior to digitization. Since the Matheson Museum is small and the collection has little documentation, the items in the Bone Collection remain in storage. The museum also has a small staff (only two part-time employees and several volunteers) and very limited hours, making it difficult to schedule research opportunities. The portion of the Bone Collection housed at the University of Florida is also difficult to see since it is a part of the non-circulating special collections. Given that the collection is split in two, simultaneous access

---


20 Ask UF, “When was UF integrated and who was the first black student?” University of Florida, http://www.questions.ufl.edu/general/facts/198/ (accessed 22 February 2009).
to the entire collection is nonexistent; while comprehensive research or viewing is nearly impossible. Yet now that it is freely available online its visibility and therefore research potential have increased. The collection can be found by searching the University of Florida Libraries electronic finding aides, which describe the physical collection and provide a link to the digital content. It can also be found through searches of keywords, subject, title or photographer in the University of Florida Digital Collections. Searching the University of Florida Digital Collections for Florida photographs will also lead to the Bone Collection. In addition, many of Bone’s images are also a part of the University Archives Photograph Collection and can be found by browsing that collection online.

Statistics of the digital collection demonstrate the public’s interest in these images and justify their availability. In September 2008, the Elmer Harvey Bone Collection received 36,547 online item hits. Thirteen of the top one hundred most accessed items within the University Archives Photograph Collection are also a part of the Elmer Harvey Bone Collection. Furthermore, the current preferred method of Web searching, Google, also leads one to the Bone Collection online through its top seven search results for “Elmer Harvey Bone.” These numbers represent the popularity of Mr. Bone’s images and the success of the collection’s multiple access points. For more statistics on the Elmer Harvey Bone Collection see Appendix C.

Presenting the Elmer Harvey Bone Collection online allows both institutions to provide additional information about the images. Each image has standard museum label information (title, artist/creator, material and date). Yet many images provide further information such as the address of the locale pictured along with a Google map pinpointing the location. A few images also have descriptive information regarding the image. For example, item UF00047211 “6 men on a stage, during ‘Best Beard’ Contest” gives background information about one of the
individuals pictured. “The photo is from a "best beard" contest held for Gainesville's centennial celebration in 1953. The tall man in white, with the hat, is Flake Parker, former owner of Parker's Office Supplies, a longtime downtown business. He grew the beard, won the contest, shaved off the beard, and never grew one again.” Item MH00002026, “Bendix Modern Home Laundry, N.W. 13th Street, Gainesville, FL,” identifies a building in the photograph. “The home to the right of the laundry was a boarding house for students operated by Mrs. Leggett.” Item MH00001914, “Margaret and Sarah Smith in Front of Christmas Tree,” provides biographical information about the individuals pictured. “Pictured from left to right are sisters, Margaret Smith (later Margaret Storm) and Sarah Smith (later Sarah Deck), daughters of DeWitt T. Smith and Florence P. Smith.” Many other items within the digital collection also have additional information about the image or the subject of the photograph. Additionally, since the images are presented online more information can be added as it becomes available.

Digitization preserves photographs and increases the longevity of originals. The Bone Collection was and still is in need of preservation. The collection was kept in the Matheson Museum in unacceptable storage. The photographs and negatives were housed in acid free envelopes but not acid free boxes. Although the items were stored in acid free envelopes, several photos and/or negatives were stuffed in each envelope. The result was that several photographs were stuck together, and negatives were cracked, bent, or missing corners. The glass plate negatives were suffering the most, with many plates having separated emulsion. Digitizing helped preserve these images for posterity. The process also allowed the Matheson to inventory the items that were scanned and re-house them in individual acid free envelopes and boxes. Presenting the Bone Collection online signifies a reduction in handling and environmental exposure since few will have to touch the originals in order to view them.
Figure 2-1. The Bone Studio located at 105 S.E. 1st Street, Gainesville, Florida. A) “Bone Studio and Lafayette Electronics,” n.d., 4” x 5”, item MH00002140. B) “Elmer Harvey Bone Standing in Doorway of His Studio,” n.d., 7.5” x 8”, item MH00002561. Photograph taken by Weston McDonell.

Figure 2-2. “Portrait of Glenna Jo Hair,” 1954, 5” x 7.5”, item MH00002372. The photograph was taken as an engagement announcement photo to appear in The Gainesville Sun.

Figure 2-3. “Fingate Baby, Thomas Funeral Home,” 1949, 7” x 5”, item MH00002275.
Figure 2-4. “2 Men in Swim Trunks; Coleman Clark,” c.1930, 2.5” x 3.5”, item MH00002192

Figure 2-5. “University of Florida Building Project, Dorm S,” c.1940, 5” x 7”, item MH00002146.

Figure 2-6. “Construction of Hotel Kelley (renamed Seagle Bldg),” 1926, 5” x 4”, item UF00034740.
Figure 2-7. “Construction of New Alachua County Court House,” 1960, 5” x 4”, item MH00002345.

Figure 2-8. “S. Clark Butler Standing in His Grocery Store,” n.d., 10” x 8”, item MH00002562.
In today’s overcrowded and image overloaded Internet, digitization is starting to be seen as a starting point rather than the final product. The final product is the applications in which digital surrogates are used and what can be created from them. More and more digital-image-based programs are geared toward Web 2.0 applications that rely on user interaction for their success.\textsuperscript{21} Two such Web 2.0 websites are Flickr and steve.museum.

**Flickr: The Commons and the Library of Congress**

On January 16, 2008, the Library of Congress partnered with the popular photo sharing website Flickr (www.flickr.com), to launch a pilot project titled *The Commons*. Flickr is a free and publicly accessible website where users post images and the community is invited to describe them via tags or through the comments section (see Figure 3-1). According to the Library of Congress’ 2008 project report, “*The Commons* is a designated area of Flickr where cultural heritage institutions can share photographs that have no known copyright restrictions to increase awareness of their collections.” The two main objectives of the program, as stated on *The Commons* (www.flickr.com/commons) homepage, are “to increase access to publicly-held photography collections, and to provide a way for the general public to contribute information and knowledge.” After only a year the pilot project has encouraged many others to join *The Commons*. Newer members include the Library of Virginia, the Smithsonian, the Brooklyn Museum and the George Eastman House. The program’s attractiveness is *The Commons*’ ability to increase exposure to collections as well as facilitate and enhance research.

\textsuperscript{21} Web 2.0 is defined as web-based applications designed for user interaction. Web 2.0 applications are participatory while traditional web applications are passive.
Two days after its debut, the Library of Congress reported the launch as a huge success. In those two days, the initial 3,100 photographs (which had been digitized for prior projects) were viewed 650,000 times; users commented on 420 photos and 1,200 photos had been marked as favorites. The popularity of the images and the project continues today. The following statistics are from the Library of Congress 2008 project report:

- As of October 23, 2008, there have been 10.4 million views of the photos on Flickr.
- 79% of the 4,615 photos have been made a "favorite" (i.e. incorporated into personal Flickr collections).
- 7,176 tags were added by 2,518 unique Flickr accounts.
- 82% of traffic was referred from within Flickr; only 3% came from search engines.
- More than 500 Prints and Photographs Online Catalog records have been enhanced with new information provided by Flickr members.
- Average monthly visits to all Prints and Photographs Online Catalog web pages (on the Library of Congress website) rose 20% over between January-May 2008, compared to the same period in 2007.
- Less than 25 instances of user-generated content were removed due to inappropriateness.

These statistics demonstrate the public’s interest, the popularity of Flickr and the project’s initial success.

In addition to the benefits of digitization previously mentioned, The Commons has the added benefit of user-generated information: comments and tagging. Tagging is the process of users attaching a descriptive word or phrase to an image. Tags are usually descriptive terms such as “stadium” or “baseball” but can also be proper nouns such as a person’s name. Tagging is at the heart of many Web 2.0 applications. The Commons also has a comments section, which allows users to discuss the image in more detail. Both comments and tags benefit the digitized content. The added search terms (tags) help other users find an image. For example, a photograph of a baseball game may only have in the title or caption the names of the teams.
playing, location or date. Yet users can tag this photograph with terms as general as “sports” or as specific as a player’s nickname. This aids other users searching or browsing for images that may not have found the photo otherwise. In addition, users can comment on an image in *The Commons*. Comments range from “excellent photo” to additional information and links relating to the image. The following example from the 2008 Library of Congress project report, demonstrates one of the benefits of user-generated information. A plain photo of a barn, titled "Jones Barn where dynamite was found,” prompted a dialogue (in the comments section) between Flickr participants causing several users to link the image to a *New York Times* story describing the event in the title. An additional commenter provided links to archival holdings at the University of Cincinnati that could shed further light on the photograph.22 For the Library of Congress staff, this additional research and information would have been nearly impossible to gather, given their tight schedules and long list of responsibilities, without the help of Flickr users.

Although *The Commons* is a success and has accomplished its goal of increasing awareness to collections, there are still worries and drawbacks. The first concern for many museums is the loss of control. Making images available via Flickr gives control to the users rather than the institution. The user can appropriate those images for any purpose without having to credit the institution. Providing lower resolution images can help mitigate this problem. Since the institutions participating in *The Commons* are providing images with no known copyright restrictions, there is no legal barrier to prevent users from appropriating the images. Potential mis-tagging, and therefore mis-information, by users can also result in a loss of control to the institution. The loss of authority is also a concern. Museums have traditionally held scholarly

22 “Jones Barn where dynamite was found” http://www.flickr.com/photos/library_of_congress/2163452890/
authority through dissemination of information regarding their collections. Yet with the ability for user-generated tags and comments via Flickr, the museum loses some of that authority. This should be of lesser concern to institutions since user generated information will not negate the museum’s research but rather enhance it, as seen in the previous statistics. Reiterating the value of user-generated content, Chris Anderson, editor-in-chief of *Wired Magazine*, recently told the Smithsonian that, "The problem is, the best curators of any given artifact do not work here, and you do not know them. Not only that, but you can't find them. The only way to find them is to put stuff out there and let them reveal themselves as being an expert."²³ Therefore *The Commons* is the ultimate example of collaboration. The institutions have the materials but the public provides the links to further research about those materials.

**Steve.Museum**

In 2006, the Institute of Museum and Library Sciences (IMLS) awarded a two-year National Leadership Grant to a group of museums researching social tagging/folksonomy and its application in the museum community.²⁴ Participating institutions included the Metropolitan Museum of Art, the Denver Art Museum, the Solomon R. Guggenheim Museum, the Cleveland Museum of Art, the Indianapolis Museum of Art, the Los Angeles County Museum of Art, the Minneapolis Institute of Arts, the Rubin Museum of Art, and the San Francisco Museum of Modern Art. Steve.museum is the result of their research. Steve.museum is a website (http://steve.museum) where partner institutions make available digital surrogates of items in their collections and invite the public to tag the images (see Figure 3-2). Thus creating new search terms for works of art and therefore increasing their usability and findability.


²⁴ Social tagging is the process of users adding tags (metadata) for the purpose of organization and categorization to online content. It is also referred to as folksonomy.
Steve.museum has limited benefits compared to Flickr and The Commons. The images on steve.museum are copyrighted and cannot be utilized in the same way as images from The Commons. This limits the website to being a tagging website and nothing else. Also, steve.museum does not have an area for user comments, which as previously mentioned can assist the institution’s research and enhance their catalog records. The primary benefit of steve.museum is the software that has been developed through the project. The steve tagger (the software utilized in steve.museum) is an open source program which is freely available and can be installed on any website. There are many possibilities for this program since any museum can utilize the program code on their website and tailor it to their specific needs. Therefore it provides greater control to the institution regarding information about the work of art, tags and image use. Yet because the application can be installed on the museums’ existing site, it does not provide the added benefit of multiple access and distribution points, like Flickr.
Figure 3-1. “Suffragettes with flag,” as seen in the Library of Congress “photostream” on The Commons website.
Figure 3-2. “Bazaar Through Glass Door, Bombay,” as seen in the steve tagger on the steve.museum website. http://tagger.steve.museum
The Elmer Harvey Bone Collection lacked textual information and documentation. In order to gather more information about the images I wrote a press release regarding the project and calling for community information. In September 2008 *The Gainesville Sun* published a story about the digitization project.\(^{25}\) The story attracted many people to the website as evidenced by the increase in total hits count; August had 912 total hits while September had 43,100 total hits. In addition twelve people responded to the call for information and identified people, places and events in twenty photographs. Several of the individuals identified themselves or family members in the photos. A few individuals were also grateful that we were preserving local history. One woman, who found her own engagement picture in the collection, had this to say, “This is awesome. This is a beautiful Web Site. I still have this photo. I was twenty years old when this photo was taken in 1954 - born May 22, 1934. This photo was taken in 1954, for *The Gainesville Sun* to announce my engagement to be married in 1955 for which I moved to Polk County where I resided until 2002 (see Figure 2-1).”\(^{26}\) The community’s support is integral to this project and the possibility of continued digitization of the collection. If the community does not support the digitization of the collection then it is pointless to continue the project. If we were to continue without their support, we would be providing access to items no one is interested in.

The Bone Collection has potential interest for general users and researchers alike. General users can find interest in the visual depiction of Gainesville as well as reminisce about the way things were. The mostly transient population of Gainesville, the university students, would be

---


\(^{26}\) Email correspondence with Mrs. Glenna Jo Hair Kropp. 25 September 2008.
interested to see the way Gainesville has grown and changed over the years. The collection also provides them with historical context of the city and potential research material for classes. Researchers from various fields, such as photography, history, architecture, historic preservation, anthropology, and fashion would also be interested in the collection.

As a pilot project, the digitization of the Bone Collection was a success. The community’s interest, support and subsequent involvement contributed to the success of the project. From an access standpoint, the project was successful since it grants access to a collection that was mostly inaccessible before. The popularity of the images is demonstrated in the item hit counts (see Appendix C). The interest in the Bone Collection is also demonstrated by the fact that thirteen items in the Bone Collection are among the top one hundred most accessed items of the University Archives Photograph Collection. In addition, a book publisher in Illinois requested one image from the collection, “Soldiers Waiting to Board Train,” for inclusion in a future publication.

It is my hope that this project expands past its pilot phase. I would like to see a greater number of images from the Bone Collection digitized and available online. One way to do this would be through private grants. Foundations such as the Florida Humanities Council provide grants that could fund the digitization of a large portion of the collection. The History Channel also has a granting program (“Save Our History”) that is inline with the goals of this project. I would also like to see the Matheson Museum and the University of Florida Special and Area Studies Collections collaborate and make the digitized images available on The Commons as well as the University of Florida Digital Collections. As the Library of Congress has already demonstrated, the public is willing to provide information and their willingness should be capitalized on to improve the collection’s documentation. If twelve people responded to the call
from a local newspaper, then imagine how many more would contribute when the images are presented in a more accessible and known forum. Furthermore until UFDC features a comments or tagging feature like Flickr, *The Commons* will be the easiest way to gather any additional information. Finally, I would like to see a physical exhibit of the Elmer Harvey Bone Collection. Since digital surrogates increase visits to the original, the exhibit will be popular and well attended as well as spark further conversation about the photographic history of Gainesville, Florida.
APPENDIX A
FLATBED SCANNING: USING THE EPSON EXPRESSION 10000XL

Tips

• The following section describes scanning of opaque items, not negatives.

• To save time, scan items using Adobe Photoshop (any version) rather than using the scanner’s stand-alone image capture software.

• Scanner settings must be changed and verified with each new item.

• Scan text at 300 dpi (dots per inch) - printed and typed texts, as well as simple and legible hand-written documents

• Scan images at 600 dpi (dots per inch) - photographs (prints and negatives), maps, postcards, and any other image-based item, as well as detailed or small print (both typed and hand-written) documents.

• Scan in a color-space appropriate to the source document, RGB if there is color present Grayscale if not.

• For archival quality, all files should be saved in uncompressed TIFF format.

• Post-capture processing and image adjustments should be made in Adobe Photoshop or a similar program.

Scanner Settings

• Before opening Adobe Photoshop, turn on the scanner and verify that the scan bed is clean and free and any dust or debris. If necessary, clean the glass with a lint-free cloth and a small amount of glass cleaner.

• Open Adobe Photoshop and select File → Import → Epson Expression 10000XL

---

27 This section was adapted from the Digital Library of the Caribbean digitization manual, available from http://dloc.com/?c=dloc&m=hitmanual, to which the author was a major contributor. Due to the current unavailability of the Microtek scanner in North America, a comparable scanner was selected. The settings for an Epson Expression 10000XL are used instead.
• The scanning interface will open two windows, a settings window and a preview window, both of which are seen below.

• In the settings window select the appropriate settings for your item, from those below.
  
  - Select PROFESSIONAL MODE
  
  - Below Original Settings select the following:
    - Document Type: REFLECTIVE (for opaque items such as prints)
    - Document Source: DOCUMENT TABLE
    - Auto Exposure Type: PHOTO
  
  - Below Destination Settings select the following:
- Image Type: select 8-bit Grayscale for those items without any color or badly discolored documents such as black white photos. Select 24-bit RGB for items with color.

- Resolution:
  - Text at 300 dpi - printed and typed texts, as well as simple and legible hand-written documents.
  - Images at 600 dpi - photographs (prints and negatives), maps, postcards, and any other image-based item, as well as detailed or small print (both typed and hand-written) documents.

- Document Size: do not adjust
- Target Size: original

  - Below Adjustment Settings select the following:
    - Click the CONFIGURATION button (below the Preview and Scan buttons)
    - Click the COLOR tab, select No Color Correction. Click OK.

![Configuration Dialog Box](image)

Scanning

- Place item, image down, on scanner glass. Be careful to place it as straight as possible in order to save time later. Close the scanner lid as much as possible.

- Click the PREVIEW button in the Scan Settings window. A small preview of your image will appear. Make sure the entire document is visible, if not reposition the item and repeat.
• Draw a bounding box around the entire image. If the original has 2 pages facing each other, draw a second box by selecting the dual marquee button. Arrange each box to completely include each side of the item. Once you are satisfied with the boxes positioning, click the **ALL** button. DO NOT move the boxes or change settings after pressing this button!

• Click the **SCAN** button.

**Saving Files**

• Save the digital image by selecting File → Save or File → Save As.

• Select the folder where you want to save the image and give it a sequential name such as 0001, 0002, 0003, etc.

• Uncheck the ICC profile box.

• In the drop down menu, select TIFF as the file type. In the pop-up TIFF options window select:
  - Image Compression: None
  - Pixel Order: Interleaved
  - Byte Order: IBM PC
The intent of digitization is a faithful reproduction of the original document. Therefore, images will need to be straightened, cropped and color corrected in order to accurately represent the original. In order to ensure accuracy of colors, your monitor should be calibrated about once a month. A calibration program can be purchased, such as Monaco Optix, or you may use the Adobe Gamma program, which comes pre-installed on most computers. It should be noted that color corrections should not be performed on laptop computers due to the inaccuracy of the screen.

- To use Adobe Gamma select Program Files → Common Files → Adobe → Calibration
- Open the program and follow the step-by-step instructions to calibrate your monitor.

**Straightening Images**

- To straighten crooked or skewed images:
  - Right Click the Eyedropper Tool in the Photoshop toolbox and select the Measure Tool (highlighted below).

---

28 This section was adapted from the Digital Library of the Caribbean digitization manual, available from http://dloc.com/?c=dloc&m=hitmanual, to which the author was a major contributor.
• Click and draw a line to follow the bottom of any printed text, line or image (below, line is red for purposes of illustration).

• Once the line is drawn, the computer automatically determines the angle of correction. To apply this correction select Image → Rotate Canvas → Arbitrary → Click OK.

• Using the Crop tool, remove the excess borders added during straightening. Do not crop into the image or alter the original size and/or ratio.

**Color Correction**

• If the raw scan is faint or needs slight color adjustment, select Image → Adjustment → Levels to see the Levels/Histogram.

  ![Levels Adjustment](image)

  Adjust the black, gray and white points (left to right) by sliding them in or out to improve the image. If the image is in RGB then additional adjustments can be made in each color’s channel as well as the overall tones. Be careful to not over-correct the image and eliminate details. See below for an example of a raw scan and the corrected image.
• Remember that any adjustments done can be undone as long as the file remains open. Open the History window by selecting Window → History. You can always go back several steps and re-correct your image if you are unsatisfied.
Table 1-1. Top fifty most accessed items within the Elmer Harvey Bone Collection, as of March 1, 2009

<table>
<thead>
<tr>
<th>Bib ID</th>
<th>Title</th>
<th>Hits</th>
</tr>
</thead>
<tbody>
<tr>
<td>MH00001879</td>
<td>Portrait of Virginia Crews</td>
<td>1108</td>
</tr>
<tr>
<td>MH00002141</td>
<td>Elmer Harvey Bone Standing in Front of His Photo Studio Holding Cigar</td>
<td>437</td>
</tr>
<tr>
<td>UF00047175</td>
<td>2 men and a dog with dummy in a coffin and sign &quot;Here lies Wendell Wilkie&quot;.</td>
<td>368</td>
</tr>
<tr>
<td>UF00045400</td>
<td>2 men hold string with dead ducks and squirrels attached.</td>
<td>342</td>
</tr>
<tr>
<td>MH00002317</td>
<td>Dudley Farm</td>
<td>279</td>
</tr>
<tr>
<td>UF00047220</td>
<td>An event in downtown Gainesville.</td>
<td>237</td>
</tr>
<tr>
<td>MH00002125</td>
<td>Woman Holding Fish Outside Bone Photographic Studio</td>
<td>234</td>
</tr>
<tr>
<td>UF00047211</td>
<td>6 men on a stage, during &quot;Best Beard&quot; Contest.</td>
<td>233</td>
</tr>
<tr>
<td>MH00001812</td>
<td>City of Gainesville Girls, Mr. Johnson-Wallace</td>
<td>232</td>
</tr>
<tr>
<td>UF00044728</td>
<td>A gator in a decorated car in Homecoming parade.</td>
<td>226</td>
</tr>
<tr>
<td>UF00047219</td>
<td>An elderly couple seated outside.</td>
<td>216</td>
</tr>
<tr>
<td>MH00002019</td>
<td>Car Accident, 10th Avenue, Marion Hartman</td>
<td>216</td>
</tr>
<tr>
<td>UF00045492</td>
<td>8 women by a building. Child to right. See UAPC 5252.</td>
<td>211</td>
</tr>
<tr>
<td>UF00047016</td>
<td>Beauty contestants in formal dresses on plaza downtown.</td>
<td>208</td>
</tr>
<tr>
<td>UF00030043</td>
<td>Group of men in front of a house</td>
<td>207</td>
</tr>
<tr>
<td>UF00047212</td>
<td>An older couple stands on the front porch of a house with rooms for rent.</td>
<td>204</td>
</tr>
<tr>
<td>MH00002140</td>
<td>Bone Studio and Lafayette Electronics</td>
<td>202</td>
</tr>
<tr>
<td>MH00002220</td>
<td>2 Men in Doorway at Fort Bragg</td>
<td>202</td>
</tr>
<tr>
<td>UF00047169</td>
<td>Many students in street. Dec. 6, 1928. &quot;Beat Tennessee&quot;.</td>
<td>197</td>
</tr>
<tr>
<td>MH00002000</td>
<td>Event in Hotel Thomas (Moose), Interior View</td>
<td>196</td>
</tr>
<tr>
<td>UF00045477</td>
<td>Baseball players on steps of a house.</td>
<td>193</td>
</tr>
<tr>
<td>UF00047000</td>
<td>Another view of courthouse being torn down.</td>
<td>192</td>
</tr>
<tr>
<td>UF00047195</td>
<td>7 men stand in front of tent with sign (Kelvinator appliances), Jan. 20.</td>
<td>187</td>
</tr>
<tr>
<td>UF00046899</td>
<td>View of stands and Florida Field</td>
<td>186</td>
</tr>
<tr>
<td>UF00047004</td>
<td>Line of cars on University Avenue business district.</td>
<td>185</td>
</tr>
<tr>
<td>UF00047223</td>
<td>Eight well dressed older men stand on the steps of a building.</td>
<td>184</td>
</tr>
<tr>
<td>MH00002126</td>
<td>Gainesville High School Purple Hurricane Football Team</td>
<td>181</td>
</tr>
<tr>
<td>MH00002214</td>
<td>Publix Supermarket and W.T. Grant Co. Shopping Plaza</td>
<td>175</td>
</tr>
<tr>
<td>MH00002273</td>
<td>Alachua Furniture Mfr's. Sample House</td>
<td>172</td>
</tr>
<tr>
<td>MH00002026</td>
<td>Bendix Modern Home Laundry, N.W. 13th Street, Gainesville, FL</td>
<td>169</td>
</tr>
<tr>
<td>UF00045618</td>
<td>Car with advertisements and &quot;Evening News&quot; painted on it, people standing all around.</td>
<td>167</td>
</tr>
</tbody>
</table>

29 All collection statistics, terms and definitions were generated by the Digital Library Center programmers. They have been adapted for this document. The complete list of statistics for the Elmer Harvey Bone Collection and UFDC is available at http://www.uflib.ufl.edu/ufdc/?&m=hti.
<table>
<thead>
<tr>
<th>Image Code</th>
<th>Description</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>UF00044743</td>
<td>Cake float in Homecoming parade.</td>
<td>167</td>
</tr>
<tr>
<td>UF00045407</td>
<td>Family in front of a home decorated with American flags.</td>
<td>165</td>
</tr>
<tr>
<td>UF00045463</td>
<td>Four men in a canoe on flooded street.</td>
<td>164</td>
</tr>
<tr>
<td>MH00002139</td>
<td>Band Playing at Dedication of New Federal Building, Post Office and Court House</td>
<td>163</td>
</tr>
<tr>
<td>MH00002350</td>
<td>Couple Posing in Front of Car</td>
<td>161</td>
</tr>
<tr>
<td>MH00001836</td>
<td>Anderson Hall, University of Florida</td>
<td>160</td>
</tr>
<tr>
<td>MH00001997</td>
<td>Event in Hotel Thomas (Moose), Interior View</td>
<td>159</td>
</tr>
<tr>
<td>MH00001827</td>
<td>Boy Holding Rooster on Porch</td>
<td>155</td>
</tr>
<tr>
<td>MH00002021</td>
<td>America's Number 1 Road Car, 1957 Pontiac, Marion Hartman</td>
<td>154</td>
</tr>
<tr>
<td>MH00001925</td>
<td>Funeral Home on W. University Avenue</td>
<td>153</td>
</tr>
<tr>
<td>UF00047143</td>
<td>Members of Florida Funeral Directors Association in front of a building.</td>
<td>149</td>
</tr>
<tr>
<td>MH00002260</td>
<td>Cars in Line for Drive In Windows at Florida National Bank</td>
<td>148</td>
</tr>
<tr>
<td>UF00045504</td>
<td>Woman stands at counter in grocery store.</td>
<td>147</td>
</tr>
<tr>
<td>UF0004726</td>
<td>Homecoming parade Oct. 17, 1958.</td>
<td>146</td>
</tr>
<tr>
<td>UF00045483</td>
<td>Glass broken, Family group on steps of a house.</td>
<td>145</td>
</tr>
<tr>
<td>UF00045671</td>
<td>Young boy in store beside sign, &quot;V for Victory&quot;.</td>
<td>143</td>
</tr>
<tr>
<td>UF00047161</td>
<td>Horse drawn carriage with well dressed people riding in it.</td>
<td>143</td>
</tr>
<tr>
<td>MH00002290</td>
<td>Class of 1945, Melrose High School</td>
<td>142</td>
</tr>
<tr>
<td>UF00047201</td>
<td>Construction of Hotel Kelley (Seagle Bldg) showing 10 stories.</td>
<td>141</td>
</tr>
</tbody>
</table>

Table 1-2. Elmer Harvey Bone digital collection history, as of March 1, 2009

<table>
<thead>
<tr>
<th>Date</th>
<th>Total Hits</th>
<th>Sessions</th>
<th>Main Pages</th>
<th>Browses</th>
<th>Item Hits</th>
<th>Text Searches</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>January</td>
<td>29</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>29</td>
<td>0</td>
</tr>
<tr>
<td>February</td>
<td>11</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>11</td>
<td>0</td>
</tr>
<tr>
<td>March</td>
<td>422</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>422</td>
<td>0</td>
</tr>
<tr>
<td>April</td>
<td>44</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>44</td>
<td>0</td>
</tr>
<tr>
<td>May</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>June</td>
<td>102</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>102</td>
<td>0</td>
</tr>
<tr>
<td>July</td>
<td>31</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>31</td>
<td>1</td>
</tr>
<tr>
<td>August</td>
<td>37</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>37</td>
<td>7</td>
</tr>
<tr>
<td>September</td>
<td>42</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>42</td>
<td>1</td>
</tr>
<tr>
<td>October</td>
<td>26</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>26</td>
<td>2</td>
</tr>
<tr>
<td>November</td>
<td>45</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>45</td>
<td>1</td>
</tr>
<tr>
<td>December</td>
<td>29</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>29</td>
<td>0</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>January</td>
<td>33</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>33</td>
<td>6</td>
</tr>
<tr>
<td>February</td>
<td>19</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>18</td>
<td>1</td>
</tr>
<tr>
<td>March</td>
<td>38</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>38</td>
<td>5</td>
</tr>
<tr>
<td>April</td>
<td>39</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>39</td>
<td>3</td>
</tr>
</tbody>
</table>

30 The digital Elmer Harvey Bone Collection was created in May 2008. All statistics prior to this date represent the items which had been previously digitized that are now integrated into the Bone Collection online.
<table>
<thead>
<tr>
<th>Month</th>
<th>Zoomable Views</th>
<th>Citation Views</th>
<th>Map Views</th>
<th>Static Views</th>
</tr>
</thead>
<tbody>
<tr>
<td>May</td>
<td>605</td>
<td>49</td>
<td>98</td>
<td>107</td>
</tr>
<tr>
<td>June</td>
<td>2103</td>
<td>62</td>
<td>112</td>
<td>153</td>
</tr>
<tr>
<td>July</td>
<td>951</td>
<td>56</td>
<td>94</td>
<td>245</td>
</tr>
<tr>
<td>August</td>
<td>912</td>
<td>47</td>
<td>112</td>
<td>167</td>
</tr>
<tr>
<td>September</td>
<td>43100</td>
<td>1020</td>
<td>1553</td>
<td>4607</td>
</tr>
<tr>
<td>October</td>
<td>5572</td>
<td>162</td>
<td>318</td>
<td>697</td>
</tr>
<tr>
<td>November</td>
<td>1905</td>
<td>104</td>
<td>157</td>
<td>262</td>
</tr>
<tr>
<td>December</td>
<td>1101</td>
<td>44</td>
<td>68</td>
<td>139</td>
</tr>
</tbody>
</table>

Table 1-3. Item views within the Elmer Harvey Bone digital collection, as of March 1, 2009

Table definitions

- **Total Hits:** Hits are the actual page hits. Each time a person goes to www.uflib.ufl.edu/ufdc it counts as a hit. The UFDC statistics are cleaned so that hits from robots, which search engines use to index websites, are removed. If they were not removed, the hits on all
collections and items would be much higher. Web usage statistics are always somewhat fallible, and this is one of the means for ensuring better quality usage statistics.

- **Sessions**: Each time a person goes to www.uflib.ufl.edu/ufdc it counts as a hit, but that means a single user going to the site repeatedly can log a large number of hits. Sessions provide a better statistic for how many different “unique” users are using the site. Sessions include all hits from a particular IP address (the user’s computer web address when connected) as recorded in the web log file within an hour. This is also a fallible statistic since users’ IP addresses are frequently reused on networks.

- **Main Pages**: Main pages are the home or landing pages, the search pages, and the contact pages in a collection.

- **Browses**: Browses include hits against standard browses, such as *All Items* and *New Items* (when available).

- **Item Hits**: Item hits include hits at the item level only.

- **Zoomable Views**: For each item, the default view is set to the page item. All items also include a “Zoomable View” that is not selected by default. The “Zoomable Views” counts the number of times a user chooses the “Zoomable View” for an item.

- **Citation Views**: For each item, the default view is set to the page item. All items also include a “Citation View” that is not selected by default. The “Citation Views” counts the number of times a user chooses the “Citation View” for an item.

- **Thumbnail Views**: For each item, the default view is set to the page item. All items also include a “Thumbnail View” that is not selected by default. The “Thumbnail Views” counts the number of times a user chooses the “Thumbnail View” for an item.

- **Text Searches**: Text searches are item-level searches within the text of a single document. This returns the pages upon which the term or terms appear.

- **Map Views**: For each item, the default view is set to the page item. All items also include a “Map View” that is not selected by default. The “Map Views” counts the number of times a user chooses the “Map View” for an item.

- **Static Views**: For each item in UFDC, a static page is generated for search engines (Google, Yahoo, etc.) to index. When a UFDC item appears in the search results of a standard search engine, the link forwards the user to the static page. Any additional navigation moves the user into the dynamically generated pages within UFDC. Therefore, these numbers represent the number of users that entered UFDC from a search engine.
LIST OF REFERENCES


58


Lourdes Santamaría-Wheeler was born and raised in Miami, Florida. She moved to Gainesville in 1999, where she resides today. In 2003 she earned a Bachelor of Fine Arts in Creative Photography and a minor in Art History from the University of Florida. In January 2005 she began her current position as the Digital Production Supervisor at the University of Florida Digital Library Center. Wanting to pursue a Master of Arts in Museology, she enrolled at the University of Florida in the fall of 2005. During her graduate studies, she interned at both the Samuel P. Harn Museum of Art and the Matheson Museum. She has served as a technical trainer, consultant and translator for the Digital Library of the Caribbean. Ms. Santamaría-Wheeler will graduate from the Museum Studies program in May 2009.